2001

The Tasmanian Gateway: Cenozoic Climatic and Oceanographic Development

Neville F. Exon
*Australian Geological Survey Organisation*

James P. Kennett
*University of California, Santa Barbara*

Mitchell J. Malone
*Texas A&M University*

Henk Brinkhuis
*Utrecht University*

George C.H. Chaproniere
*Australian National University*

See next page for additional authors

Follow this and additional works at: https://scholarcommons.usf.edu/msc_facpub

Part of the Life Sciences Commons

Scholar Commons Citation
https://scholarcommons.usf.edu/msc_facpub/661

This Conference Proceeding is brought to you for free and open access by the College of Marine Science at Scholar Commons. It has been accepted for inclusion in Marine Science Faculty Publications by an authorized administrator of Scholar Commons. For more information, please contact scholarcommons@usf.edu.
PROCEEDINGS OF THE OCEAN DRILLING PROGRAM

The Tasmanian Gateway: Cenozoic Climatic and Oceanographic Development Sites 1168–1172

Prepared by the OCEAN DRILLING PROGRAM, TEXAS A&M UNIVERSITY in cooperation with the NATIONAL SCIENCE FOUNDATION and JOINT OCEANOGRAPHIC INSTITUTIONS, INC.
Frontispiece 1. Relief map showing the setting of all sites drilled during Leg 189. Site 1168 is on the segmented and canyoned western Tasmania margin, Site 1172 is on the isolated east Tasman Plateau, and the other sites are on the South Tasman Rise. Strike-slip motion along the western margin of Tasmania (north northwest-south southeast) is shown by one major fault scarp formed >43 Ma. Similar motion along the western margin of the South Tasman Rise and within the rise (north-south) is shown by several fault scarps formed 43–33 Ma.
Frontispiece 2. Leg 189 core across the Eocene/Oligocene boundary on the East Tasman Plateau, showing gray late Eocene mudstones, green latest Eocene glauconitic siltstones, and white early Oligocene chalks. This core summarizes the profound changes that occurred as the Tasmanian Gateway opened.
PROCEEDINGS OF THE
OCEAN DRILLING PROGRAM

Volume 189
Initial Reports
The Tasmanian Gateway: Cenozoic Climatic and
Oceanographic Development

Covering Leg 189 of the cruises of the Drilling Vessel JOIDES Resolution
Hobart, Tasmania, to Sydney, Australia
Sites 1168–1172
11 March–6 May 2000

SHIPBOARD SCIENTISTS
Neville F. Exon, James P. Kennett, Mitchell J. Malone,
Hendrik Brinkhuis, George C.H. Chaproniere, Atsuhito Enyu, Patrick Fothergill, Michael D. Fuller,
Marianne Grauert, Peter J. Hill, Thomas R. Janecek, Daniel C. Kelly, Jennifer C. Latimer, Stefan Nees,
Ulysses S. Ninnemann, Dirk Nürnberg, Stephen F. Pekar, Caroline C. Pellaton, Helen A. Pfluh,
Christian M. Robert, Kristeen L. McGonigal Roessig, Ursula Röhl, Stephen A. Schellenberg,
Amelia E. Shevenell, Catherine E. Stickley, Noritoshi Suzuki, Yannick Touchard, Wuchang Wei,
Timothy S. White

SHIPBOARD STAFF SCIENTIST
Mitchell J. Malone

VOLUME EDITOR  VOLUME GRAPHIC DESIGNER  VOLUME PRODUCTION EDITOR
John M. Scroggs  Jennie L. Lamb  Cathy Martin
Reference to the whole or to part of this volume should be made as follows:

Print citation for Chapter 1:

CD-ROM volume citation:

CD-ROM chapter citation:

ISSN
Library of Congress 87-642-462
Effective publication dates of ODP Proceedings

According to the International Code of Zoological Nomenclature, the date of publication of a work and of a contained name or statement affecting nomenclature is the date on which the publication was mailed to subscribers, placed on sale, or when the whole edition is distributed free of charge, mailed to institutions and individuals to whom free copies are distributed. The mailing date, not the printing date, is the correct one.

The printing date of this volume: May 2001

The mailing dates of recent Proceedings of the Ocean Drilling Program:
  Volume 186 (Initial Reports): August 2000
  Volume 187 (Initial Reports): January 2001
  Volume 188 (Initial Reports): March 2001
  Volume 170 (Scientific Results): February 2001
  Volume 171A (Scientific Results): December 2000
  Volume 171B (Scientific Results): April 2001

Copies of this publication may be obtained from Publications Distribution Center, Ocean Drilling Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-9547, USA. See the ODP publication list at www-odp.tamu.edu/publications or contact ODP for prices and ordering information. Orders for copies require advance payment.
**PUBLISHER’S NOTES**

This volume also appears on the World Wide Web. Any corrections, revisions, or additions will be noted in the chapter (see “Chapter Notes”) at [www-odp.tamu.edu/publications/](http://www-odp.tamu.edu/publications/).

This publication was prepared by the Ocean Drilling Program, Texas A&M University, as an account of work performed under the international Ocean Drilling Program, which is managed by Joint Oceanographic Institutions, Inc., under contract with the National Science Foundation. Funding for the program was provided by the following agencies at the time of this cruise:

- Australia/Canada/Chinese Taipei/Korea Consortium for Ocean Drilling: Department of Primary Industries and Energy (Australia), Natural Resources Canada, National Taiwan University in Taipei, and Korean Institute for Geology, Mining and Minerals
- Deutsche Forschungsgemeinschaft (Federal Republic of Germany)
- European Science Foundation Consortium for Ocean Drilling (Belgium, Denmark, Finland, Iceland, Ireland, Italy, The Netherlands, Norway, Portugal, Spain, Sweden, and Switzerland)
- Institut National des Sciences de l'Univers–Centre National de la Recherche Scientifique (INSU–CNRS) (France)
- Marine High-Technology Bureau of the State Science and Technology Commission of the People’s Republic of China
- National Science Foundation (United States)
- Natural Environment Research Council (United Kingdom)
- University of Tokyo, Ocean Research Institute (Japan)

Any opinions, findings, and conclusions or recommendations expressed in this publication are those of the author(s) and do not necessarily reflect the views of the National Science Foundation, the participating agencies, Joint Oceanographic Institutions, Inc., Texas A&M University, or Texas A&M Research Foundation.
Abbreviations for names of organizations and publications in ODP reference lists follow the style given in Chemical Abstracts Service Source Index (published by American Chemical Society).

The bulk of the shipboard-collected data from this leg is available on the World Wide Web and is accessible at www-odp.tamu.edu/database. If you cannot access this site or need additional data, please contact the ODP Data Librarian, Ocean Drilling Program, Texas A&M University, College Station TX 77845-9547, USA (e-mail: database@odpemail.tamu.edu).

A site map showing the drilling locations for this leg and maps showing the drilling locations of all Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available on this CD-ROM in PDF format. These maps were produced using Generic Mapping Tools (GMT) of Paul Wessel and Walter H.F. Smith (imina.soest.hawaii.edu/gmt/).

Cover photograph is of the JOIDES Resolution in Hobart, Tasmania, by ODP Photographer John Beck.
FOREWORD

BY JOINT OCEANOGRAPHIC INSTITUTIONS, INC.

This volume presents scientific and engineering results from the Ocean Drilling Program (ODP). These results address the scientific and technical goals of the program, which are focused on the study of the dynamics of Earth’s interior and environment, the evolution of oceanic crust, and the fluctuations of climate. In addition, study of the Earth’s deep biosphere is an emergent research objective.

ODP, an international partnership of scientists and research institutions from 22 countries, operates the drillship JOIDES Resolution. This state-of-the-art research vessel contains eight levels of laboratories and other scientific facilities required for carrying out the program’s objectives.

The management of ODP involves a partnership of scientists and governments. International oversight and coordination are provided by the ODP Council, which is made up of representatives from the member countries. Overall scientific and management guidance is provided by representatives from the Joint Oceanographic Institutions for Deep Earth Sampling (JOIDES).

Joint Oceanographic Institutions, Inc. (JOI), a nonprofit consortium of 14 U.S. oceanographic institutions, serves as the National Science Foundation’s prime contractor for ODP. JOI implements scientific objectives, plans, and recommendations of the JOIDES committees through major subcontracts to Texas A&M University (TAMU) for science operations and to Lamont-Doherty Earth Observatory (LDEO) of Columbia University for geochemical and geophysical well-logging services.

JOI, TAMU, and LDEO have worked together successfully for many years to manage the Ocean Drilling Program. We look forward to many exciting discoveries and continued international collaboration as we further our scientific mission, especially the planning for the future of ocean drilling beyond 2003.

Steven R. Bohlen
President of the Joint Oceanographic Institutions and Executive Director of the Ocean Drilling Programs
Washington, D.C.
MEMBER ORGANIZATIONS OF THE JOINT OCEANOGRAPHIC INSTITUTIONS FOR DEEP EARTH SAMPLING (JOIDES)

University of California at San Diego, Scripps Institution of Oceanography
University of California, Santa Cruz
Columbia University, Lamont-Doherty Earth Observatory
University of Florida
University of Hawaii, School of Ocean and Earth Science and Technology
University of Miami, Rosenstiel School of Marine and Atmospheric Science

University of Michigan, College of Literature, Science, and the Arts
Rutgers, The State University of New Jersey, Institute of Marine and Coastal Sciences and Faculty of Arts and Sciences
Oregon State University, College of Oceanic and Atmospheric Sciences
University of Rhode Island, Graduate School of Oceanography
Texas A&M University, College of Geosciences
University of Texas at Austin, Institute for Geophysics

*At time of publication. See Publisher’s Notes, p. 7, for list of funding agencies at time of cruise. For an up-to-date list of current member organizations and office contact information, see the ODP Web site: www.oceandrilling.org.
University of Washington, College of Ocean and Fishery Sciences
Woods Hole Oceanographic Institution
Australia/Canada/Chinese Taipei/Korea Consortium for Ocean Drilling: Department of Primary Industries and Energy (Australia), Natural Resources Canada, National Taiwan University in Taipei, and Korean Institute for Geology, Mining and Minerals
European Science Foundation Consortium for Ocean Drilling (Belgium, Denmark, Finland, Iceland, Ireland, Italy, The Netherlands, Norway, Portugal, Spain, Sweden, and Switzerland)
Federal Republic of Germany, Bundesanstalt für Geowissenschaften und Rohstoffe
France, Institut National des Sciences de l’Univers–Centre National de la Recherche Scientifique (INSU–CNRS)
Japan, University of Tokyo, Ocean Research Institute
People’s Republic of China, Marine High-Technology Bureau of the State Science and Technology Commission of the People’s Republic of China
United Kingdom, Natural Environment Research Council

OCEAN DRILLING PROGRAM (ODP)
Web site: www.oceandrilling.org

ODP SCIENCE ADVISORY STRUCTURE (JOIDES)
JOIDES Office
University of Miami—RSMAS
4600 Rickenbacker Causeway
Miami FL 33149, USA
Tel: (305) 361-4668; Fax: (305) 361-4632
E-mail: joides@rsmas.miami.edu
Web site: joides.rsmas.miami.edu
ODP PROGRAM MANAGER
Joint Oceanographic Institutions, Inc.
1755 Massachusetts Avenue, NW, Suite 700
Washington DC 20036-2102, USA
Tel: (202) 232-3900; Fax: (202) 462-8754
E-mail: joi@brook.edu
Web site: www.joi-odp.org

ODP SCIENCE OPERATOR
Ocean Drilling Program
Texas A&M University
1000 Discovery Drive
College Station TX 77845-9547, USA
Tel: (979) 845-2673; Fax: (979) 845-4857
E-mail: odp@odpemail.tamu.edu
Web site: www.odp.tamu.edu

ODP LOGGING SERVICES
Borehole Research Group
Lamont-Doherty Earth Observatory
Columbia University
Route 9W
Palisades NY 10964, USA
Tel: (845) 365-8341; Fax: (845) 365-3182
E-mail: borehole@ldeo.columbia.edu
Web site: www.ldeo.columbia.edu/BRG/ODP

ODP SITE SURVEY DATA BANK
Lamont-Doherty Earth Observatory
Columbia University
Route 9W
Palisades NY 10964, USA
Tel: (845) 365-8542; Fax: (845) 365-8159
E-mail: odp@ldeo.columbia.edu
Web site: www.ldeo.columbia.edu/databank
LEG 189 PARTICIPANTS*

SHIPBOARD SCIENTIFIC PARTY

Neville F. Exon  
Co-Chief Scientist  
Petroleum and Marine Division  
Australian Geological Survey Organisation  
PO Box 378  
Canberra ACT 2601  
Australia  
nevile.exon@agso.gov.au

James P. Kennett  
Co-Chief Scientist  
Department of Geological Sciences and Marine Science Institute  
University of California, Santa Barbara  
Santa Barbara CA 93106  
USA  
kennett@magic.geol.ucsb.edu

Mitchell J. Malone  
Staff Scientist/Inorganic Geochemist  
Ocean Drilling Program  
Texas A&M University  
1000 Discovery Drive  
College Station TX 77845-9547  
USA  
malone@odpemail.tamu.edu

Henk Brinkhuis  
Palynologist  
Laboratory of Palaeobotany and Palynology  
Utrecht University  
Budapestlaan 4  
Utrecht 3584 CD  
The Netherlands  
h.brinkhuis@bio.uu.nl

*Addresses at time of cruise, except where updated by the leg participants before publication.
George C.H. Chaproniere  
Paleontologist (foraminifers)  
Department of Geology  
The Australian National University  
Canberra ACT 0200  
Australia  
george.chaproniere@anu.edu.au

Atsuhito Ennyu  
Sedimentologist  
Department of Geosciences  
Pennsylvania State University  
437 Deike Building  
University Park PA 16802  
USA  
aennyu@psu.edu

Patrick Fothergill  
LDEO Logging Staff Scientist  
Department of Geology  
Borehole Research  
University of Leicester  
University Road  
Leicester LE1 7RH  
United Kingdom  
paf10@leicester.ac.uk

Michael D. Fuller  
Paleomagnetist  
Hawaii Institute of Geophysics and Planetology  
University of Hawaii at Manoa  
2525 Correa Road  
Honolulu HI 96822  
USA  
mfuller@soest.hawaii.edu

Marianne Grauert  
Sedimentologist  
Geographical Institute  
University of Copenhagen  
Oester Voldgade 10  
1350 Copenhagen K  
Denmark  
marianne@grauert.dk  
mg@geogr.ku.dk

Peter J. Hill  
Stratigraphic Correlator  
Petroleum and Marine Division  
Australian Geological Survey Organisation  
GPO Box 378  
Canberra ACT 2601  
Australia  
peter.hill@agso.gov.au
Thomas R. Janecek  
**Stratigraphic Correlator**  
Antarctic Research Facility  
Florida State University  
108 Carraway Building  
Tallahassee FL  32306-4100  
USA  
janecek@gly.fsu.edu

Daniel C. Kelly  
**Paleontologist (foraminifers)**  
Department of Geology and Geophysics  
Woods Hole Oceanographic Institution  
266 Woods Hole Road  
Mail Stop #23, Clark Building  
Woods Hole MA  02543  
USA  
dkelly@whoi.edu

Jennifer C. Latimer  
**Physical Properties Specialist**  
Department of Geology  
Indiana University/Purdue University,  
Indianapolis  
723 West Michigan Street  
Indianapolis IN  46202  
USA  
jclatime@iupui.edu

Kristeen McGonigal  
**Paleontologist (nannofossils)**  
Department of Geology  
Florida State University  
108 Carraway Building  
Tallahassee FL  32306-4100  
USA  
roessig@gly.fsu.edu

Stefan Nees  
**Sedimentologist**  
GEOMAR  
Christian-Albrechts-Universität zu Kiel  
Wischhofstrasse 1-3  
24148 Kiel  
Federal Republic of Germany  
snees@geomar.de

Ulysses S. Ninnemann  
**LDEO Logging Staff Scientist**  
Borehole Research Group  
Lamont-Doherty Earth Observatory  
Columbia University  
Route 9W  
Palisades NY  10964  
USA  
ulysses@ldeo.columbia.edu
Dirk Nürnberg
Inorganic Geochemist
GEOMAR
Department of Paleoceanology
Research Center of Marine Geosciences at
University of Kiel
Christian-Albrechts-Universität zu Kiel
Wischhofstrasse 1-3, Building 8
24148 Kiel
Federal Republic of Germany
dnuernberg@geomar.de

Stephen F. Pekar
Sedimentologist
Department of Geological Sciences
Rutgers, The State University of New Jersey
Wright Labs
Piscataway NJ 08854
USA

Present address (6 March 2001):
Lamont-Doherty Earth Observatory
Columbia University
Route 9W
Palisades NY 10964
USA
pekar@ldeo.columbia.edu

Caroline C. Pellaton
Sedimentologist
Département de Géologie et de Paléontologie
Université de Genève
13 rue des Maraîchers
1211 Genève 4
Switzerland
caroline.pellaton@terre.unige.ch

Helen A. Pfuhl
Paleontologist (foraminifers)
Godwin Laboratory
University of Cambridge
Pembroke Street/NMS
Cambridge CB2 3SA
United Kingdom
hap21@cus.cam.ac.uk

Christian M. Robert
Sedimentologist
Centre d’Ocanologie de Marseille
Luminy case 901
13288 Marseille Cedex 09
France
robert@com.univ-mrs.fr
Ursula Röhl  
**Physical Properties Specialist**  
Fachbereich Geowissenschaften  
Universität Bremen  
Postfach 33 04 40  
Bremen 28334  
Federal Republic of Germany  
uroehl@allgeo.uni-bremen.de

Stephen A. Schellenberg  
**Sedimentologist**  
Department of Earth Sciences  
University of California, Santa Cruz  
EMS-A232  
1156 High Street  
Santa Cruz CA  95064  
USA  
schellen@es.ucsc.edu

Amelia E. Shevenell  
**Sedimentologist**  
Department of Geological Sciences  
University of California, Santa Barbara  
Santa Barbara CA  93106  
USA  
amelia@magic.geol.ucsb.edu

Catherine E. Stickley  
**Paleontologist (diatoms)**  
Environmental Change Research Centre  
Department of Geography  
University College London  
26 Bedford Way  
London WC1H 0AP  
United Kingdom  
c.stickley@ucl.ac.uk

Noritoshi Suzuki  
**Paleontologist (radiolarians)**  
Institute of Geology and Paleontology  
Tohoku University  
Aoba, Aramaki  
Sendai, Miyagi 980-8578  
Japan  
suzuki.noritoshi@nifty.ne.jp

Yannick Touchard  
**Paleomagnetist**  
CNRS  
CEREGE, Domaine de L’Arbois  
Europole Mediterranean L’Arbois,  
BP 80  
13545 Aix-en-Provence Cedex 4  
France  
touchard@cerege.fr
Wuchang Wei  
Paleontologist (nannofossils)  
Scripps Institution of Oceanography  
Geoscience Research Division  
University of California, San Diego  
La Jolla CA  92093-0244  
USA  
wwei@ucsd.edu

Timothy S. White  
Organic Geochemist  
EMS Environment Institute  
The Pennsylvania State University  
2217 Earth-Engineering Science Building  
University Park PA  16802  
USA  
tswhite@essc.psu.edu
TRANSOCEAN SEDCO FOREX OFFICIALS

Captain Tom Hardy
Master of the Drilling Vessel
Overseas Drilling Ltd.
707 Texas Avenue South, Suite 213D
College Station TX 77840-1917
USA

Wayne Malone
Drilling Superintendent
Overseas Drilling Ltd.
707 Texas Avenue South, Suite 213D
College Station TX 77840-1917
USA

SHIPBOARD PERSONNEL

Chris Bodley
Information Services Representative

Gar Esmay
Marine Laboratory Specialist
(Curator)

Charlie Endris
Marine Laboratory Specialist
(Paleomagnetism)

Mike Friedrichs
Downhole Tool Specialist

Randy Gjesvold
Marine Electronics Specialist

Dennis Graham
Marine Laboratory Specialist
(Chemistry)

Ron Grout
Operations Manager

Gus Gustufson
Marine Laboratory Specialist
(Downhole Tools/Thin Section)

Mark Hagerty
Marine Laboratory Specialist
(Photographer)
Burney Hamlin
Laboratory Officer

Michiko Hitchcox
Marine Laboratory Specialist
(Yeoperson)

Jessica Huckemeyer
Marine Laboratory Specialist
(Assistant Curator)

Maniko Kamei
Marine Laboratory Specialist
(Core Lab/X-Ray)

Dave Kotz
Marine Computer Specialist

Anastasia Ledwon
Marine Laboratory Specialist
(Physical Properties)

Chris Lernihan
Marine Laboratory Specialist
(Technician)

Tony Muir
Downhole Tool Engineer

Bob Olivas
Marine Laboratory Specialist (X-Ray)

Chieh Peng
Marine Laboratory Specialist
(Chemistry)

Don Sims
Marine Laboratory Specialist
(Underway Geophysics)

Johanna Suhonen
Marine Laboratory Specialist
(Downhole Measurements)

Kerry Swain
Schlumberger Engineer

Hardus van Bosch
Marine Electronics Specialist

Jason Wilsterman
Marine Laboratory Specialist
(Technician)

Laura Wright
Marine Computer Specialist
<table>
<thead>
<tr>
<th>Name</th>
<th>Position</th>
</tr>
</thead>
<tbody>
<tr>
<td>Karen Benson</td>
<td>Production Editor</td>
</tr>
<tr>
<td>Brenda Bridges</td>
<td>Editor</td>
</tr>
<tr>
<td>Lori J. Cagle</td>
<td>Editor</td>
</tr>
<tr>
<td>Gudelia (“Gigi”) Delgado</td>
<td>Senior Publications Coordinator</td>
</tr>
<tr>
<td>Patrick H. Edwards</td>
<td>Production Editor</td>
</tr>
<tr>
<td>Edward W. Flax</td>
<td>Student Assistant</td>
</tr>
<tr>
<td>Jaime A. Gracia</td>
<td>Senior Production Editor</td>
</tr>
<tr>
<td>Mendy A. Harrison</td>
<td>Assistant Editor</td>
</tr>
<tr>
<td>Ann Klaus</td>
<td>Publication Services Manager</td>
</tr>
<tr>
<td>Kathryn M. Kozelsky</td>
<td>Graphic Designer</td>
</tr>
<tr>
<td>Jennie L. Lamb</td>
<td>Graphic Designer</td>
</tr>
<tr>
<td>Nancy H. Luedke</td>
<td>Graphic Designer</td>
</tr>
<tr>
<td>Cathy Martin</td>
<td>Production Editor</td>
</tr>
<tr>
<td>Amy McLeod</td>
<td>Student Assistant</td>
</tr>
<tr>
<td>Nancy McQuistion</td>
<td>Reference Editor</td>
</tr>
<tr>
<td>Angeline T. Miller</td>
<td>Senior Editor</td>
</tr>
<tr>
<td>Mary Elizabeth Mitchell</td>
<td>Production Assistant</td>
</tr>
<tr>
<td>Deborah L. Partain</td>
<td>Senior Graphic Designer</td>
</tr>
<tr>
<td>Lorri L. Peters</td>
<td>Editor</td>
</tr>
<tr>
<td>Katerina E. Petronotis</td>
<td>WWW Administrator</td>
</tr>
<tr>
<td>M. Kathleen Phillips</td>
<td>Publications Specialist</td>
</tr>
<tr>
<td>Jennifer Pattison Rumford</td>
<td>Electronic Publications Specialist</td>
</tr>
<tr>
<td>John M. Scroggs</td>
<td>Editor</td>
</tr>
<tr>
<td>Kenneth Sherar</td>
<td>Production Editor</td>
</tr>
<tr>
<td>Ann Yeager</td>
<td>Distribution Specialist</td>
</tr>
</tbody>
</table>

*At time of publication.
ACKNOWLEDGMENTS

We, the science party of Leg 189 of the Ocean Drilling Program, express our thanks to those who provided the invaluable help that made the drilling expedition to the Tasmanian Gateway an outstanding success. Leg 189 could not have succeeded without the site survey data and other support provided by the Australian Geological Survey Organisation. Surveys by the German research vessel Sonne and the IFREMER research vessel L’Atalante added critical site survey data. We especially thank those who helped write the various versions of the proposal, some of whom did not participate in the leg. We greatly appreciated the dedicated support of the captain, the crew, the drilling team, and the ODP technicians aboard the JOIDES Resolution. The sometimes heavy weather during our leg placed the drill crew and the ODP technical staff under considerable pressure. Finally, the hard work and competence of the ODP Publication Services staff have ensured the timely publication of this volume.
CD-ROM CONTENTS: CHAPTERS

1. Leg 189 Summary
2. Explanatory Notes
3. Site 1168
4. Site 1169
5. Site 1170
6. Site 1171
7. Site 1172

CD-ROM CONTENTS: APPENDIX

Appendix: Magnetic Experiments
CD-ROM CONTENTS: CORE DESCRIPTIONS

Visual core descriptions (VCDs), smear-slide data tables, and digital core images are included in this section. VCDs and smear-slide data tables are combined into one PDF file for each site. ASCII versions of the smear-slide data tables are also available (see “ASCII Tables”).

Site 1168

Visual Core Descriptions · Smear Slides

Site 1169

Visual Core Descriptions · Smear Slides

Site 1170

Visual Core Descriptions · Smear Slides

Site 1171

Visual Core Descriptions · Smear Slides

Site 1172

Visual Core Descriptions · Smear Slides
**CD-ROM Contents: ASCII Tables**

This CD-ROM contains ASCII versions of biostratigraphic **data tables** presented in the volume chapters and **smear-slide data tables** presented under “Core Descriptions.” A complete listing of the ASCII data tables can be found on the next two pages.

You can access these data directly from the PDF files. Depending on your computer platform, the following information applies.

**PC Computers**
By default, clicking on a filename with a .TXT extension will launch the Notepad application. You can configure your computer’s operating system so that files on this CD with .TXT extensions automatically open in other software, such as Microsoft Excel. Follow these steps from the pull-down menu: Windows 95 and NT operating systems: View > Options > File Types; and Windows 98 systems: View > Folder Options > File Types.

**MAC Computers**
All table files with .TXT extensions will automatically open into Excel. If you do not have Excel installed on your computer, you may view these files through other spreadsheet or text-editor programs. Open the application of your choice, select File > Open, and open the ASCII file.

**UNIX Computers**
You can open files with .TXT extensions in any text editor or spreadsheet program, but not directly from PDF files.

Chapter 3  Chapter 5  Chapter 7
Chapter 4  Chapter 6  Smear-slide data tables
Chapter 3, Site 1168
*Table T12.* Reliable biostratigraphic events identified, Site 1168.

Chapter 4, Site 1169
*Table T7.* Combined bioevents used for the age model, Site 1169A.

Chapter 5, Site 1170
*Table T13.* Biostratigraphic events, Site 1170.

Chapter 6, Site 1171
*Table T13.* Biostratigraphic events identified, Site 1171.

Chapter 7, Site 1172
*Table T11.* Selected dinocyst datums, Holes 1172A and 1172D.

Smear-Slide Data Tables
- **Hole 1168A** smear-slide table.
- **Hole 1168B** smear-slide table.
- **Hole 1168C** smear-slide table.
- **Site 1169** smear-slide table.
- **Site 1170** smear-slide table.
- **Hole 1171A** smear-slide table.
- **Hole 1171B** smear-slide table.
- **Hole 1171C** smear-slide table.
- **Hole 1171D** smear-slide table.
- **Hole 1172A** smear-slide table.
- **Hole 1172B** smear-slide table.
- **Hole 1172C** smear-slide table.
- **Hole 1172D** smear-slide table.
CD-ROM CONTENTS: DRILLING LOCATIONS MAPS

A site map showing the drilling locations for this leg and maps showing the drilling locations of all Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available in PDF format.

ODP Leg 189 Site Map
ODP Map (Legs 100–189)
DSDP Map (Legs 1–96)
RELATED LEG DATA

DOWNHOLE LOGGING AND CORE DATA

A second CD-ROM is included with this volume. The “Log and Core Data” CD contains Leg 189 depth-shifted and processed downhole logging data and shipboard core logging data (gamma-ray attenuation bulk density, natural gamma radiation, magnetic susceptibility, color reflectance, and moisture and density). The downhole logging data are provided by the Borehole Research Group at the Lamont-Doherty Earth Observatory, Wireline Logging Operator for ODP.

The majority of the logging data included on the CD are available on the World Wide Web at www.ldeo.columbia.edu/BRG/ODP. If you cannot access this site or want to order the CD, please contact: ODP Logging Services Operator, Lamont-Doherty Earth Observatory, Route 9W, Palisades NY 10964, USA; Tel: (845) 365-8341; Fax: (845) 365-3182; E-mail: borehole@ldeo.columbia.edu.

The majority of the core data on the CD are available on the Web at www.odp.tamu.edu/database. If you cannot access the ODP database or need additional data, please contact: ODP Data Librarian, Ocean Drilling Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-9547, USA; Tel: (979) 845-8495; Fax: (979) 458-1617; E-mail: database@odpemail.tamu.edu.
COMPILED ELECTRONIC INDEX

The Compiled Electronic Index of the Proceedings of the Ocean Drilling Program included on the Initial Reports CD-ROM contains individual indexes of Volumes 101–171B. The indexes are contained in the directory titled ODPINDEX and are named ###NDX.PDF (### = the leg number). These indexes can be searched individually or collectively.
<table>
<thead>
<tr>
<th><strong>189IR.PDF</strong></th>
<th>(Preliminary pages and table of contents)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>README.PDF</strong></td>
<td>(Information about the volume CD-ROM)</td>
</tr>
<tr>
<td><strong>README.TXT</strong></td>
<td>(Information about the volume CD-ROM in ASCII format)</td>
</tr>
<tr>
<td><strong>ACROREAD</strong></td>
<td>(Acrobat Reader 4.0.5 installation software and instructions for different platforms)</td>
</tr>
<tr>
<td><strong>MAACS</strong></td>
<td></td>
</tr>
<tr>
<td><strong>WINDOWS</strong></td>
<td></td>
</tr>
<tr>
<td><strong>UNIX</strong></td>
<td></td>
</tr>
<tr>
<td><strong>README.TXT</strong></td>
<td></td>
</tr>
<tr>
<td><strong>MAPS</strong></td>
<td>(Drilling locations maps)</td>
</tr>
<tr>
<td><strong>189_MAP.PDF</strong></td>
<td>(Leg 189 site map)</td>
</tr>
<tr>
<td><strong>ODPMAP.PDF</strong></td>
<td>(ODP map, Legs 100 through 189)</td>
</tr>
<tr>
<td><strong>DSDPMAP.PDF</strong></td>
<td>(DSDP map, Legs 1 through 96)</td>
</tr>
<tr>
<td><strong>VOLUME</strong></td>
<td>(Leg 189 Initial Reports volume)</td>
</tr>
<tr>
<td><strong>CHAPTERS</strong></td>
<td>(Volume chapters)</td>
</tr>
<tr>
<td><strong>IR189_01.PDF</strong></td>
<td>(Leg 189 Summary)</td>
</tr>
<tr>
<td><strong>IR189_02.PDF</strong></td>
<td>(Explanatory Notes)</td>
</tr>
<tr>
<td><strong>IR189_03.PDF</strong></td>
<td>(Site 1168)</td>
</tr>
<tr>
<td><strong>IR189_04.PDF</strong></td>
<td>(Site 1169)</td>
</tr>
<tr>
<td><strong>IR189_05.PDF</strong></td>
<td>(Site 1170)</td>
</tr>
<tr>
<td><strong>IR189_06.PDF</strong></td>
<td>(Site 1171)</td>
</tr>
<tr>
<td><strong>IR189_07.PDF</strong></td>
<td>(Site 1172)</td>
</tr>
<tr>
<td><strong>APPENDIX</strong></td>
<td>(Volume appendix)</td>
</tr>
<tr>
<td><strong>MAG_EXP.PDF</strong></td>
<td>(Magnetic Experiments)</td>
</tr>
<tr>
<td><strong>COR_1168.PDF</strong></td>
<td>(Site 1168)</td>
</tr>
<tr>
<td><strong>COR_1169.PDF</strong></td>
<td>(Site 1169)</td>
</tr>
<tr>
<td><strong>COR_1170.PDF</strong></td>
<td>(Site 1170)</td>
</tr>
<tr>
<td><strong>COR_1171.PDF</strong></td>
<td>(Site 1171)</td>
</tr>
<tr>
<td><strong>COR_1172.PDF</strong></td>
<td>(Site 1172)</td>
</tr>
<tr>
<td><strong>IMAGES</strong></td>
<td>(PDF files of core images)</td>
</tr>
<tr>
<td><strong>S_SLIDES</strong></td>
<td>(Sites 1168 through 1172)</td>
</tr>
<tr>
<td><strong>INDEX.PDX</strong></td>
<td>(Acrobat file used to enable Acrobat Search of the 189 Initial Reports)</td>
</tr>
<tr>
<td><strong>ODPINDEX</strong></td>
<td>(Compiled Electronic Index of the Proceedings of the Ocean Drilling Program)</td>
</tr>
<tr>
<td><strong>101NDX.PDF</strong></td>
<td>through 171BNDX.PDF</td>
</tr>
<tr>
<td><strong>NDX.PDX</strong></td>
<td>(Index files)</td>
</tr>
</tbody>
</table>